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Micro Focus COBOL Server 6.0 Release
Notes
These release notes contain information that might not appear in the Help. Read them in their entirety
before you install the product.
Note:
•

•

This document contains a number of links to external Web sites. Micro Focus cannot be
responsible for the contents of the Web site or for the contents of any site to which it might link.
Web sites by their nature can change very rapidly and although we try to keep our links up-to-date,
we cannot guarantee that they will always work as expected.
Check the Product Documentation section of the Micro Focus SupportLine Documentation Web
site for any updates to the documentation which might have been uploaded.

COBOL Server provides the execution environment for applications created with any IDE variant of Visual
COBOL.
Updating from earlier versions of COBOL Server
Note: This applies to Windows platforms only.
As a result of an internal change of your product, you must at least relink any executable programs
compiled with a product version earlier than 4.0, to make them compatible with the latest run-time system.
However, a full recompilation of your source code is the recommended action, to allow your executables to
benefit from the product's latest programming and performance enhancements.
Relinking an executable without recompiling means using the original object code with the cbllink utility,
using the current version of Visual COBOL. Original object code is typically the binary file output (usually
containing the .obj extension) produced during the original compilation process. An application can
contain one or more binary files.
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What's New
Enhancements are available in the following areas:
•
•
•
•
•
•
•
•
•

Containers
Data File Tools
Enterprise Server
Enterprise Server Security
Enterprise Server Common Web Administration
File Handling
Multi-Threaded Applications
New Platform Support
Problem Determination

Containers
Back to Top
Support has been added to enable you to work with containers from the IDE. In particular you can now
create a Dockerfile for a COBOL project, and build, debug and run a COBOL project in a container, all from
the IDE.
Support has been added to enable the use of tools that are compatible with the Open Container Initiative
(OCI) on platforms where they are supported. This is currently available on Red Hat Enterprise Linux 8.

Data File Tools
Back to Top
The following enhancements have been made to the Data File Editor:
•
•
•
•
•

Double-byte character sets are now supported within the editor.
Insert mode is now available when editing a formatted record, except for numeric fields.
When editing DBCS data in EBCDIC files, the required Shift-out and Shift-in characters are
automatically added when editing a formatted record and you are editing in Insert mode.
You can now load and unload structure files for an open data file.
A ruler at the top of the editing pane can be toggled on/off.

Enterprise Server
Back to Top
The following enhancements are available:
•

IPv6 support (EAP) - This feature is in Early Adopter Program (EAP) release status. Some Enterprise
Server components and features now support Internet Protocol version 6 (IPv6) network addressing
and connectivity. Due to limitations with IPv4, IPv6 is becoming more common within corporate
networks and on the public Internet. In some cases, the use of IPv6 can improve interoperability and
simplify network configuration.

What's New
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•

Administrative Commands - the add command in cascertreg now contains new options (-cwi
setting, -dcas setting, -issuer, and -subject).

Enterprise Server Security
Back to Top
This release provides the following enhancements:
•

Micro Focus Secrets file storage permissions

•

The Micro Focus Secrets feature (also known as the Vault feature) provides centralized storage for
sensitive information such as passwords, with some protection against accidental disclosure or
discovery by unauthorized users. Prior to this release, the only supported storage mechanism was a
conventional file containing encrypted data. In this release, the permissions on the storage file and on
the Secrets configuration file are set more restrictively to help protect the secrets.
Certificate wildcard support

•

The X.509 digital certificates used to identify servers when making TLS (SSL) connections permit the
use of fully-qualified domain names with wildcards for some parts of the name. This enables
administrators to use a single certificate issued to, for example, *.mycorp.com for any number of servers
with fully-qualified names like www.mycorp.com, server1.mycorp.com, and so on. These wildcardbearing certificates are now supported by client programs using Micro Focus communication technology
when validating a server's certificate.
Improved ACL wildcard support

•

In the Access Control Lists used for resource access control with LDAP-based security in Enterprise
Server, the ".**" wildcard sequence now behaves more similarly to mainframe RACF. A number of
additional options for wildcard processing are also available.
PAM ESM module

•

On Linux platforms, Enterprise Server now includes an External Security Manager module which
integrates with the Pluggable Authentication Modules (PAM) operating system feature. The PAM ESM
module can be used to authenticate Enterprise Server users with the same mechanism used for Linux
users, or with any other mechanism available through PAM.
PKIX compliance for TLS certificate validation

•

The standard for using X.509 digital certificates to authenticate servers when making TLS (SSL)
connections is known as PKIX, for Public Key Infrastructure (X.509). It is defined by a series of IETF
RFC documents, currently RFC 5280 and others. In previous releases, the certificate validation
performed by this product did not conform to PKIX in a number of ways, most notably in using DNS
address-to-name resolution in an attempt to match a certificate to a host. With this release, clients using
Micro Focus Common Client technology, such as COBOL web service proxy programs, CAS utility
programs, and customer applications that use the CICS Web Services Interface feature, will by default,
use stricter procedures for validating certificates which more closely conform to PKIX. This improves
TLS security and interoperability.
Security improvements for XML parsing
In this release the third-party components used for parsing XML data have been updated, or have had
bug fixes integrated into the version used by Micro Focus, to address published security vulnerabilities.
Also, XML external-entity support has been disabled except where it is required by a particular product
feature; this prevents XML External Entity (XXE) attacks on customer systems by attackers who can
trick a customer application into parsing a malicious XML document.

Enterprise Server Common Web Administration (ESCWA)
Back to Top
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This release offers the following new features and improvements:
•

•
•

•

•
•

MFDS User Interface functionality replacement - ESCWA can now communicate with remote MFDS
instances, and displays the equivalent pages of MFDS. Configuring regions, and their IMS, PL/I, MQ,
and XA options, and security, is now available.
ESMAC User Interface functionality replacement - ESCWA can communicate with remote ESMAC
instances, and can replicate functionality and display all the information provided by ESMAC.
Configurable User Interface access - you can now configure the ESCWA security manager to control
user and group access to certain aspects of the user interface, such as, native, and security menu
items.
Usability improvements
• Starting and stopping regions from the navigation tree.
• The native menu items are not displayed if the region features are not configured correctly.
• Configuration of the display colors for MFDS hosts and regions to distinguish them with ease.
Scale-Out support - ESCWA has improved the way it displays a Scale-Out Repositories (SORs)
association with its PAC and member regions.
Redis support - Redis is supported as a SOR when running this product in a PAC. Features include:
•
•

•

Redis cluster support
A Mfredis configuration file - enables you to configure reconnection when any network errors occurs.
You can also use the file to configure Lua scripts tracing on servers.
• Authentication support for the standalone Redis server.
Kubernetes support - when ESCWA is run in a Kubernetes cluster, it is now possible to configure it to
automatically discover the pods hosting MFDS within the cluster, and display them in the ESCWA user
interface.

File Handling
Back to Top
Fileshare password files can now be stored in the Vault Facility, ensuring that sensitive user credentials are
encrypted. Firstly, create the password file in the usual way, and then upload it, with a path of
microfocus/fh, using the mfsecretsadmin utility.
To ensure the Fileshare server uses the file stored in the vault, start the server with the /uv option.

Multi-Threaded Applications
Back to Top
This release includes the following improvements:
•

•

Improved validation of detached threads on UNIX - the reliability for applications with many threads,
when using the CBL_THREAD_KILL routine and during abnormal process termination, such as when
an error occurs, has been improved.
Thread local storage optimizations - the thread termination in applications with many threads has been
optimized.

New Platform Support
Back to Top
Support is now available for COBOL Server for the following additional platforms to the same level that
other UNIX platforms (different than Linux) are supported:

What's New
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•
•

Ubuntu Linux 18.04.x (LTS) on 64-bit Intel (x86-family)
CentOS v7 and v8 on Intel x86-64

For a full list of the supported operating systems, check the Product Availability section on the Micro Focus
SupportLine Web site: http://supportline.microfocus.com/prodavail.aspx.

Problem Determination
Back to Top
The following enhancement is available:
•
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Consolidated Tracing Facility (CTF) on UNIX - CTF is now always present during process
termination, such as when an application, or a third-party code, calls exit() directly.

Significant Changes in Behavior or Usage
This section describes significant changes in behavior or usage. These changes could potentially affect the
behavior of existing applications or impact the way the tools are used.
The numbers that follow each issue are the Support Incident Numbers followed by the Reported Problem
Incident (RPI) number (in parentheses).
•
•
•
•
•
•
•
•
•
•
•

Adis
Data Tools
DB2
Documentation
Enterprise Server
Enterprise Server Common Web Administration
Enterprise Server Security
File Handling
Micro Focus Directory Server
Run-Time System
SQL Option for DB2

Adis
Back to the list
•

In RM/COBOL, the ACCEPT of a screen with an input field beyond the end of the screen would operate
as if the field was at the last character of the screen. Previously, ADIS would ignore any fields past the
end of the screen. Now, with Dialect"RM" set and the appropriate ADISCTRL settings, behavior will now
match RM/COBOL in this case.
3138718 (1112690)

Common Communications Interface
Back to the list
•

The default TLS Security Level has been increased from 0 to 1. This change will not affect any user that
has specified their own security options. Users relying upon the default TLS security options might find
that some old clients that are restricted to the use of weak ciphers will no longer be able to connect.
See "Security Levels" and "Specifying a Server Protocol and Cipher Suite Preference" in your product
Help for more information on the change to Security Level 1.

Data Tools
Back to the list
•

•

You are no longer able to modify data in a structured record that is identified as comp-2 floating point an alert is displayed if attempted. This is in order to prevent the data becoming corrupted.
3213037 (1118867)
Data File Tools now utilizes the configurable codesets facility to use a variety of character sets - see
'Working with Different Character Sets' in the documentation for more information.
3161243 (1114482)

DB2
Back to the list

Significant Changes in Behavior or Usage
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•

There is no longer a problem using an XML CLOB host variable in COBOL and PL/I program SQL
statements when compiling with the DB2 ECM Compiler directive.
3204413 (1118115)

Documentation
Back to the list
•

The information about the -flag and warn compiler options has been updated.
3190928 (1120000)

Enterprise Server
Back to the list
•

•

•
•

IF an XA open string uses the BATCHONLY option, CRCN will not monitor the XA connection to the
resource manager. If the BATCH SEP encounters a severe XA error, the batch SEP will be recycled
until the connection is recovered. This emulates the previous version of the XA reconnect feature when
ES_XA_????_NB_RETRIES=-1 was set. Consequently, if an open string contains BATCHONLY, only a
batch SEP will be able to access the resource manager and, as CRCN is a CICS transaction, it will not
monitor this entry.
3213379 (1118913)
The initPac option for the caspac command line utility has a change in behavior. Prior to PU5, if the
command detected that there were active regions in the PAC, the command would return an error and
not initialize the PAC. This only occurred when: 1. There are active regions in the PAC. 2. There are no
active regions in the PAC, but a region has shutdown without notifying the PAC SOR (PSOR), for
example, if the region was killed. In this case, it was not possible to cold start a PAC without manually
correcting the appropriate value in the PSOR. The initPac option will now prompt for confirmation on
whether you really wants to initialize the PAC, giving you the option to cancel. CAUTION: Only use this
option for scenario 2, ensuring that no cas* or mfcs processes remain for regions within the PAC. If it is
used when there are active regions in the PAC, the regions will no longer function correctly.
(642125)
Enterprise Server now supports Redis Cluster as a SOR. See "Prerequisites" in the "Scale-Out
Performance and Availability Clusters" chapter in your product Help for more information.
When compiled with the XAID Compiler directive, JCL batch SQL applications now work correctly when
MFDBFH is enabled.
3223257 (1119804)

Enterprise Server Common Web Administration
Back to the list
•
•

•
•

By default, ESCWA now runs on port 10086.
When using the Vault Facility, the ESM passwords are now accessed by the ESM’s Universal Unique
Identifier (UUID) which makes the key for the vault. If this UUID cannot be found it uses the old name
based mechanism as the key for the vault. Note: All new ESMs have a UUID that conforms to 4122
RFC. The earlier ESM UID standard is still supported.
PAC names are now limited to eight characters or fewer in ESCWA.
The default ESCWA configuration file now sets ESCWA to run in loopback-only mode.

Enterprise Server Security
Back to the list
•
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The MLDAP ESM Module for Enterprise Server now interprets the ".**" wildcard sequence in a manner
closer to that of mainframe RACF. This behavior is configurable. See "Wildcards for Resource, User,
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and Group Names" and "MLDAP ESM Module Custom Configuration Information" in your product Help
for more information.
3206992 (1118359)
File Handling
Back to the list
•

The supervisor password is no longer displayed when cobfsclose is executed from the command line.

•

3195772 (1117571)
Usernames in the Fileshare password file are no longer obfuscated; they are shown in plain text.

•

•

3120656 (641976)
Fileshare can now read a password file stored in the Vault Facility. Use the /uv option when starting
Fileshare to read the specified password file from the vault. Note: You must have uploaded the
password file to the vault before starting Fileshare.
File and folder names that are deployed to PostgreSQL datastores are now case-insensitive. This
ensures consistency of behavior with DB2 and SQL Server datastores.

Micro Focus Directory Server
Back to the list
•

UNC paths are no longer supported when importing or exporting to MFDS by default. To re-enable
them, set the environment variable MFDS_ALLOW_UNC to 'Y'.

Run-Time System
Back to the list
•

Previously, the value of the fill character and the option to use it were ignored in the RM window control
block. With this fix, the character will be used if Dialect"RM" is set and an appropriate ADISCTRL
configuration is used.
3138692 (1112552)

SQL Option for DB2
Back to the list
•

The XDB Service name has been shortened.
3195822 (1119897)

Significant Changes in Behavior or Usage
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Known Issues
Refer to the Known Issues and Restrictions topic in the Product Information section of your product Help.
•
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The Server Core form of Windows Server 2019 is not supported.

Resolved Issues
The numbers that follow each issue are the Support Incident Numbers followed by the Reported Problem
Incident (RPI) number (in parentheses).
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•

Adis
Character Animator
Common Communications Interface
Data Tools
Dockerfiles
Documentation
Enterprise Server
Enterprise Server Auditing
Enterprise Server Common Web Administration
Enterprise Server Security
File Handling
Form Designer
Header-to-Copy Utility
Licensing
Micro Focus Common Client
Micro Focus Directory Server
MF Server Administrator (GUI)
Run-Time System
Setup
SQL: COBSQL
SQL: DB2
SQL: OpenESQL
SQL Option for DB2
XML Support

Adis
Back to the list
•

•
•

•

•

A single field is no longer padded to the right when the SIZE clause data-name is greater than the PIC
clause and all the other fields have the PROTECT attribute.
3223862 (1119916)
An ACCEPT on SECURE fields no longer produces unwanted characters.
3221450 (1119807)
Using JUST and ZERO-FILL in a CONTROL clause with ADISCF option 16 set to 3 no longer causes
an RTS 114.
3198021 (1117521)
ACCEPT ON ESCAPE KEY and ACCEPT ON ESCAPE data-item now return the correct key-code in
RM/COBOL for function keys and escape. Note that the complete list of the returned key codes are not
100% compatible with RM/COBOL for all keys.
You no longer receive an RTS 114 error when the UNIX environment variable COLUMNS > 164 for
DISPLAY AT LINE COLUMN syntax.

Resolved Issues
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Character Animator
Back to the list
•

•
•

•

A Perform Step of a CALL statement in INT code, after using the Do function, and then changing the
execution point with the Reset function, now steps over the CALL correctly.
3222172 (1119750)
When detaching the debugger from a process on Solaris, the process no longer crashes.
3213587 (1118926)
Two new command line options for Animator can be used to speed up the Animation of coredumps for
applications with a large number of programs. Specifying these new options "FASTLOAD" and
"FASTEXIT" on the command line will result in Animator starting and stopping significantly quicker. See
the documentation for details on these new options.
3212276 (1118852)
CBL_EXIT_PROC routines can now be debugged correctly.

•

3208380 (1118433)
Querying an OCCURS ... DEPENDING ON ... where the item is zero is now treated as an invalid query
and the item is not shown.

•

3201182 (1117795)
When zooming and using Perform Step/Out over applications with many programs which have many
COPY statements, performance is improved.
3197159 (1118692)

Common Communications Interface
Back to the list
•

•

When CCI shared memory was processing multiple simultaneous broken connections and data at the
same time, it was possible that the data could not be read.
3195698 (1117370)
ssltrc.txt is no longer created with an extra character in the file extension.

Data Tools
Back to the list
•

•

The dfconv command line utility now supports a new option "-s" - this option skips DBCS checking
during conversion, in order to improve performance. This option should only be used from within a
DBCS locale, and only when you are sure that the data you are dealing with is from a SBCS.
3213092 (1118872)
When running the DFCONV command line batch interface, a new option -F (or -f) allows only the fixed
text output to display; no dynamic updates are displayed to the console after each record is processed.
3163542 (1115730)

•

Trying to open a PDS file in DFED no longer results in out-of-bounds exceptions.

•

3214578 (1119499)
On UNIX, opening empty structure files no longer fails and produces an RTS 114 error message.

•

3208560 (1118685)
Structure files can now be loaded and unloaded after a data file has been opened.
3181265 (1116352)

•
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On UNIX, using the Up and Down buttons to navigate the records no longer causes Data Tools to hang
and loop at several rows.

•

3208560 (1118686)
Conditional structure now work with EBCDIC files where the condition field is not at the beginning of the
record.
3204158 (1118166)

Dialog System
Back to the list
•

The Export process in Dialog System no longer fails with RTS164 error.
3200921 (1117781)

Dockerfiles
Back to the list
•

esadm is the default user for all the different container images.

Documentation
Back to the list
•

The documentation has been updated to explicitly state that the FOLDER tag, used in extfh.cfg, only
supports the use of local folders; it does not support the use of networked folders.

•

3212247 (1118782)
The documentation has been corrected in relation to the supported data types allowed in a stored
procedure definition file.

•

3207946 (1118435)
The note at the head of the list of run-time tunables, stating that the tunables are for native code only,
has been removed. Any native-only restrictions for tunables are mentioned in the topics of each tunable.

•

3207815 (1118381)
The error message description for the warning message COBCH1237 has been corrected. It also now
contains a link to the Compiler directive topic (REENTRANT) that it relates to.

•

3205344 (1118169)
The product Help for the software requirements has been updated to indicate that on 64-bit Red Hat 7
you only need to install glibc-2.17*.x86_64 and glibc-2.17*.i686.

•
•

•

3201443 (1118038)
The cbllink option -s has been correctly removed from the documentation.
3200100 (1117719)
To create an EXTENDEDESDS file, the docs now state that you must use a combination of
IDXFORMAT"15" and the EXTENDEDESDS option.
3195595 (1117298)
The syntax diagram for indexed file formats (format 4) has been updated in the documentation - topic:
The File Control Entry. It now indicates that WITH [NO] DUPLICATES can be specified on the record
key, as an MF extension.

•

3177534 (1115898)
The documentation on the FILE_TRACE configuration variable (used within Database Connnectors)
now includes details on the level of tracing that is possible.

•

3164533 (1117209)
The RM/COBOL compatibility documentation now makes it clear that the DIALECT"RM" directive
should not be applied to managed COBOL.
3139755 (1112643)

Resolved Issues
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•

•

•

•
•
•
•
•
•

•

The documentation now includes the sequence in which the Run-Time System will attempt to locate a
requested .lng file - see 'Compiling and Deploying a Message File'
2869115 (1106127)
The context-sensitive reserved words, particularly those relating to the ACU dialect, have been
relocated to the Context-Sensitive Reserved Words topic. (They previously resided in the Reserved
Words Table topic.)
If you are building a self-contained callable shared object on a Linux platform, and will be calling
COBOL modules built to .int or .gnt files, you must specify the following additional options when you link
the main (non-COBOL) executable: -Wl,-zexecstack For example: gcc -m32 -o mymainexe mymain.o -g
-ldl -Wl,-zexecstack
The documentation has been updated to clarify the default behavior when the ALIGN directive is
specified without either OPT or FIXED.
The documentation for the Micro Focus Database Handler now clarifies when a region and cross-region
database is required (in the Configuration Requirements section).
The sample code listed in 'Typedef - User Defined USAGE or Structure' has been corrected.
The documentation has been corrected for the TYPEDEF clause - the list of clauses not permitted for
use when TYPEDEF is specified is now accurate.
The documentation has been updated to state that the maximum number of PERFORM ranges in a
program (65535) is also applicable to .NET and JVM COBOL programs.
All erroneous references to the TRUNC, BS2000-OFFLOAD, and INFORETURN directives have been
removed from the documentation.
3223245 (1119786)
All erroneous references to the FLAGCD directive have been removed from the documentation.

•

3223242 (1119785)
All erroneous references to the [NO]OLDSTRSUB directive have been removed from the
documentation.

•

3223240 (1119783)
On UNIX, MFDS can run as a non-root user on a port number equal or greater than 1024. See "To Run
the Directory Server as a Non-Root User" in your product Help for more information.

•

3213301 (1118928)
The documented example for the mf.mfdbfh CTF component now contains the correct settings in order
for the trace to be successful.

•

3203127 (1118015)
The documentation has now been updated with the correct definition for the CCITCPS_fsname variable,
used within Fileshare.

•

3192544 (1117368)
The DD Statements topic has been updated to include correct values for XTEP2 and its alias
DSNTEP2.

•
•

3168080 (1115120)
The documentation now correctly states that the CBL_CREATE_CORE library routine is for native
COBOL use only.
Ensure that you back up your secrets configuration file, secrets.cfg. Before you install a new version of
your product. By default, the secrets.cfg file is located in the %ProgramFiles(x86)%\Micro Focus
\Enterprise Developer\etc (Windows) or $COBDIR/etc (UNIX) directory. Restore the backed up
configuration file once the product installation is complete.
3216092 (1119162)

•
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The documentation now includes details of the MFJ_STRICT_CASE environment variable, which can
be used to maintain the case of physical file names passed to MVSCATIO by the catalog API, and other
utilities.

Enterprise Server
Back to the list
•

TS queues that were created with an expiry interval and stored in Redis would have their expiry interval
corrupted when a subsequent READQ TS was performed on that queue. The expiry interval is no
longer modified during the life of the queue.
3221103 (1119598)

•

•

•

In a PAC, when a JES initiator was terminated, if the job was in the Dispatch queue the lock was not
removed for the dispatch queue SYSZJOBD.
3226274 (1120084)
It is now possible to use casfile -p to change the current path of a closed file or, if the file is cataloged, to
change the DSNAME from the specified DD NAME.
3224800 (1119969)
An issue causing an RTS 114 on DFSRRC00 related to disabled xa entries has been resolved.

•

3223838 (1119845)
You can now set the environment variable ES_PAC_NO_GLOBAL_LOG=Y if you do not want all the
messages from all console.log files for all the regions in a PAC to be stored in the PSOR CasPacLog.

•

3222549 (1119714)
CICS Web requests greater than 32 Kb to secure regions no longer incorrectly receive a 403
(Forbidden) response.

•

3222308 (1119752)
Switching on the active HSF file could cause a thread in the castrc process to go into a tight loop and
use a lot of CPU.

•

3219692 (1119546)
A MalformedResponseException error when using channels and containers on ECI calls has been
resolved.

•

3217992 (1119653)
Strings with special characters were sometimes being truncated or causing a malformed XML error. The
whole string is now being returned without any truncation or errors.

•

•

•
•

•

3217170 (1119681)
A CCSID Error 0002 could occur when converting certain strings to UTF-8, if the strings contain
characters that expand from single to multi-byte during the conversion. The reason for this was that the
converted string was longer than the maximum length specified for the field. Instead of resulting in an
error, the data is now truncated. This matches the behavior on the mainframe.
3217170 (1119262)
The Historical Statistics Facility (HSF) post-processor utility casfhsf has been enhanced to output time
intervals of from 1 to 9999 seconds. An option is now provided to optionally split the date/time output
column into a date column and a time column. The maximum number of columns has been increased to
172,800 for 32-bit systems, and to 1,296,000 for 64-bit systems. The number of transactions within an
interval that meet its specified system response time criteria is now reported correctly.
3214504 (1119179)
Calling into an entry point on an already loaded program no longer causes memory leaks.
3214021 (1119003)
An empty XML element in the SOAP response message no longer results in an ARRAY_TOO_SMALL
error.
3212477 (1118802)
Tranclass MaxActive is now honoured in PAC configurations.
3209901 (1118571)
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•
•

•
•

•

•

3208071 (1118414)
The initialization of a Service Execution Process could be interrupted by a request which provoked a
security call before the local ESM context had been established. This resulted in an error which would
cause the server to shutdown immediately. This has been fixed.
3208021 (1118431)
An issue on a START TRANSID with TERMID executed from an EBCDIC program has been fixed.
3206507 (1118272)
The permissions for resources (such as TSQUEUE) were being checked every time they were used in a
transaction. Now they are checked once per transaction and the result of that check is used on
subsequent requests.
3206471 (1118690)
All BATCHONLY MQ resource managers accessed from the same DSNRLI program are now security
checked. Note that DSNRLI is limited to opening only one MQ resource at a time.
3205339 (1118173)
If one or more jobs had a shared lock on a dataset (DISP=SHR) and another job was waiting for
exclusive access (DISP=OLD) on the same dataset, the latter would be granted the lock when any one
of the other jobs completed. The file would not be available for exclusive use and this would result in a
9/65 error, file locked status on open. This has now been resolved and the exclusive lock is not granted
until all shared locks have been released.

•

3201463 (1117839)
Previously, INQ TRANCLASS could fail and return a TCIDERR response code if CASTSC was handling
a heavy load.

•

3200414 (1117738)
ITR requests (such as file requests) are not sent to the transient SEP running the EZASOKET CICS
transaction.

•

•

•
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The command line help for casstart now includes information about the /m option.

3200370 (1117767)
Invoking any of the CAS* utilities (such as casout) against an enterprise server instance running on a
machine with a host name which exceeds 40 characters in length no longer results in a failure to find
the service.
3200011 (1117816)
Previously, a high volume of events in the system could cause shared memory constraints. This was
because the system generated the events irrespective of what the event manager exits were checking
for. It is now possible to avoid this by setting the filter strings in the event manager exits. This ensures
that only the required events are generated and helps to avoid any further shared memory constraints.
3199174 (1117679)
Previously, a high volume of events in the system could cause shared memory constraints. This was
because the system generated the events irrespective of what the event manager exits were checking
for. It is now possible to avoid this by setting the filter strings in the event manager exits. This ensures
that only the required events are generated and helps to avoid any further shared memory constraints.

•

3199174 (1117680)
ESCERTPAS can now return spaces as the passphrase to allow for certificates that do not have a
passphrase.

•

3196872 (1117431)
The following APIs are now supported: MQCRTMH, MQBUFMH, MQMHBUF, MQDLTMH MQSETMP,
MQINQMP, and MQDLTMP.

•

3196430 (1117373)
The performance when accessing PPTs for a program that has already been invoked in the same task
has been improved.
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•

3195445 (1117554)
In the case of OPERCMDS, you need to call the security exit only if the esm-input-parms pointer has
been provided. This helps to avoid receiving an RTS 114 error message.

•

3195205 (1117377)
An issue where a process recovery caused the entire region to crash has been resolved.

•

3192471 (1117060)
Sysout output from the casout utility larger than 64K is now displayed correctly on the screen.

•

3192406 (1117734)
Previously, console.000 was always overwritten when console.log max size was specified.

•

3192214 (1117565)
In MQ series support, the MQCSP block which can be passed on an MQCONNX call and carries user
credentials, was not being converted. This resulted in MQ connection failures.

•

3191698 (1117032)
When an alternate user ID is supplied on an MQ call, it is now authorized against the server's active
ESMs.

•

3183523 (1117005)
Under certain circumstances, a batch job which used EZSOKET calls could abend for exceeding its job
card's TIME parameter before that period had expired.

•

3181745 (1116242)
The association of a XA switch module with a batch unit of work now returns an error if the XAR cannot
be associated. This change might affect DSNRLI, DSNALI, and TSO in Batch(IKJEFTxx) processing.

•

3178489 (1118208)
The fixed transaction property for a terminal resource was not being honored correctly.

•

3176086 (1115790)
An intermittent issue with SSTM jobs not running after the region has started has been resolved.

•
•
•

•
•

•

3175925 (1115789)
HSF records following a date rollover are no longer intermittently recorded as occurring on the previous
day.
An issue which caused a memory corruption on shutdown when using JCL HSF has been resolved.
Hexadecimal prefixes can now be defined in Scale-Out Repository (SOR) models. See "PAC and SOR
Environment Variables" in your product Help for more information. A new exit, TSTDSRUE, has been
provided to determine whether or not to direct a TS or TD access request to a SOR at queue access
time. Usage of this exit causes any SOR models that have been defined to be ignored. See
"Configuring TS and TD Queues for SOR Storage" in your product Help for more information.
The XML export of resource definitions now ignores any resources that are in groups that have names
starting with "DFH".
Security Fix: A vulnerability within ESMAC which made the Web UI more susceptible to reverse
tabnabbing has been removed.
3216053 (1119150)
If MFDS_DNS_RESOLVE=Y is set, the resolved hostname of the requested address for a listener is
used for the ESMAC URL from MFDS, even if the listener is specified with an IP address in the listener
definition.

•

3194907 (1117388)
Some issues with sorting jobs on the spool page have been resolved.

•

3194166 (1117179)
ITRs are now routed to the target SEP via castsc.
3193937 (1117152)
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•

An issue with Reply to console page in ESMAC has been fixed.
3192888 (1117078)

•

•

The ESXDBOPC RM switch module has been updated to provide further clarification for optional openstring customization.
3223990 (1119899)
A new XA Switch build option - mssql17 - allows the use of the SQL Server ODBC 17.3 driver (and later
versions).

•

3220548 (1119748)
APPLNAME is now set when DSNRLI SIGNON is called with an argument.

•

3219384 (1119464)
After a SRRCMIT/SRRBACK call, the connection is now being set correctly.

•

3218880 (1119427)
The ODBC XA switch now initializes and starts correctly when MFDBFH is enabled.

•

3218343 (1119410)
There is no longer an issue with running an XA job after cancelling an XA job in ESMAC.

•

•
•

3218095 (1119496)
New functionality now enables you to store all or part of an XA open string in a vault using the Micro
Focus Vault Facility.
3217806 (1119289)
The ODBC switch now handles IMS BMP jobs correctly when the BATCHONLY=T option is specified.
3212998 (1119040)
XAR now uses the long username for connections during user impersonation if the new open string
option LNAME=T is specified.

•

3203042 (1117973)
The XA module for XDB now builds without any issues in the Enterprise Developer 5.0 products.

•

3199440 (1117649)
XA switch modules now recognize IMS transactions correctly.

•

3198981 (1117710)
The DB2 XA switch module now handles user impersonation and the packagepath option correctly.
3166472 (1118325)

Enterprise Server Auditing
Back to the list
•

Enterprise Server auditing no longer hangs if auditing is enabled for the External Security Facility but no
audit configuration file is present, and the Audit Manager is not running.

Enterprise Server Common Web Administration
Back to the list
•

An issue with viewing regions in ESCWA using an MF Directory Server process secured with the Micro
Focus Internal Security has been resolved.

•

The ESCWA user interface now performs validation in the same was as the Enterprise Server MFDS.

•
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3194067 (1117163)
It is now possible to add a color to a directory server's region through its General> Appearance dropdown list. This enables you to change the color of the region in the tree, and the background color of the
region's pages. This setting overrides the directory server's colors, if they were already set.

•

•

3132670 (1111980)
It is now possible to add a color to a directory server from the server's General > Appearance dropdown setting. Use this setting to change the color of the directory server in the tree, in the background
color of the directory server pages and all of its region pages.
2869809 (1105847)
The Monitor > Properties page now displays the list of Pending Requests under counts. This represents
any type of pending requests for the region.

Enterprise Server Security
Back to the list
•
•
•
•
•
•

•

•

•

mfsecretsadmin no longer fails on HP-UX platforms.
The mfsecretsadmin utility now supports specific secrets configuration files.
Invalid keys in mfsecrets no longer result in a crash.
mfsecretsadmin no longer incorrectly displays an error message when writing to a directory that does
not exist.
The secrets.cfg file has been moved to the default vault location.
Enterprise Server mainframe-style passtickets, used by the ELF and DCAS features, are now supported
when LDAP bind-mode verification is used.
3223436 (1119810)
In Enterprise Server, the External Security Facility's OS ESM module now supports the Enterprise
Server Digital Certificate Authentication Service (DCAS).
3222786 (1119760)
An Enterprise Server region running in a PAC and using MFDBFH for the region database with the
database "reslocking" feature supported, and with the External Security Feature enabled, would
periodically log messages similar to "ESFEV0331E Unable to unlock shared memory".
3218610 (1119357)
An additional configuration option related to retrying on failure, retry bind, has been added to the
MLDAP ESM Module. See MLDAP ESM Module Custom Configuration Information topic in your product
Help for more information.

•

3215526 (1119267)
The Enterprise Server External Security Facility's rule-substitution feature now supports the token $
{user_long}, which is replaced with the user's "long name".

•

3210400 (1118613)
In the Enterprise Server External Security Facility's administration, in rare circumstances, a one-byte
buffer overflow could occur when processing a list-user request, potentially resulting in heap corruption.

•

•

•

3209383 (1118627)
In an Enterprise Server security configuration with two or more security managers using the MLDAP
ESM Module, all-groups mode enabled, and group federation enabled, certain ESF Update requests
including the "Update All" button in the Enterprise Server Administration web interface could result in
users losing group membership information. This has now been fixed.
3208297 (1118513)
Enterprise Server's MLDAP ESM Module has a new option, "maximum qualifiers for initial check", which
enhances the existing "check TLQ first" option. See “MLDAP ESM Module Custom Configuration
Information” in your product Help for more information.
3201021 (1117790)
The Enterprise Server MLDAP ESM Module's tracing of the effective rule and result for Auth/XAuth
requests now includes the resource class as well as name.
3200710 (1117799)
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•

In Enterprise Server security configurations using multiple Security Managers with the MLDAP ESM
Module, where all-groups mode is enabled and federation is disabled, user group membership is now
maintained correctly.

•

3194825 (1117275)
The MLDAP ESM Module no longer generates "invalid search filter" errors when using OpenLDAP to
search for users with special characters in their LDAP Distinguished Names.

•

3194796 (1117268)
Enterprise Server on Linux now includes a PAM ESM Module, which can authenticate users using the
Pluggable Authentication Modules mechanism included with the operating system.

•
•
•

3176983 (1115874)
An issue with modifying Enterprise Server user groups with names beginning with the hash character
("#") has been corrected.
An issue with some identifiers that contain the equals sign character ("=") when using LDAP-based
security in Enterprise Server has been resolved.
es_default_ldap_openldap.ldf no longer deletes entries from the specified LDAP server. Instead, if you
are performing an upgrade you can use the new es_default_delete_ldap_openldap.ldf to delete these
old entries.

File Handling
Back to the list
•

•

•

An OPEN OUTPUT operation on an ESDS file, with directive NOFCD3 set, now correctly returns a 00
status.
3224463 (1119982)
A file status of 9/41 was sometimes incorrectly reported when a file was accessed by many users,
under intensive file I-O. This has now been fixed.
3214504 (1119352)
Any 9/41 additional status errors will not be logged to XFHLOG if /dev/null or NUL is used.

•

3214504 (1119652)
The File Handler running under Enterprise Server no longer returns a file status 500 when trying to
retrieve the next DD.

•

3211622 (1119086)
Specifying OUTDD"SYSOUT 121 R" when MF_CBLQDA=ON is set could cause a file locked status for
SYSOUT to occur.

•

3201420 (1117813)
Fileshare no longer crashes when run in background mode and signal is processed.

•

Rebuild now correctly reports the permitted number of duplicates for idxformat 12.
3201916 (1117985)

•

•

•
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Enterprise Server XA reconnections failed to register with MFDBFH following the loss of the original
connections - for example, through the use of the Db2 FORCE APPLICATIONS ALL.
3226856 (1120160)
Error messages are now reported to the Enterprise Server console, and the region start-up fails, if an
attempt is made to warm start a region using a region database that had not previously been cold
started.
3226448 (1120167)
A trace event is now output each time an I/O operation occurs that requires an XA connection and no
XA connection for the underlying datastore has been registered. This is designed to help with
diagnosing any file access problems.

•

•

•

•

•
•

•
•

•
•
•

•
•
•
•

•
•
•
•
•

3222022 (1119691)
Specifying "localhost" as the hostname to recover when using "dbfhadmin -openfiles -recover host:localhost" or "dbfhadmin -casprocess -recover -host:localhost" failed to resolve to the current
machine name, resulting in the command failing.
3221354 (1119628)
dbfhdeploy was not reporting the underlying ODBC error that resulted from a database connection
failure.
3221103 (1119661)
If a single Db2 database hosted a datastore and a region with the same name, database operations
would fail for the region if the datastore had been accessed first (and vice versa) due to the same
database connection and schema being used for both the region and the datastore.
3219905 (1119487)
The Micro Focus Database File Handler (MFDBFH) documentation now includes a reference topic
listing the database permissions required to create new databases, and to handle data files stored in a
database. Administrators can use this information when setting up roles within their database instances.
3217410 (1119273)
DB2 support has been added to MFDBFH.
3203127 (1117981)
dbfhdeploy can now be used to download files that are opened for read-only access by other processes.
Previously, you could only download only files that were not open by other processes.
3202402 (1117910)
When using a Db2 MFDBFH datastore, an exception occurred when attempting to lock an already
locked record.
dbfhadmin did not output an error message to indicate that the specified datastore URL (specified by
the -datastore: command-line option) did not have a corresponding configuration entry in the
MFDBFH.config file.
When using PostgreSQL, when a KSDS file was deleted, the associated rewrite stored procedure was
not being removed.
CAS processes using database resource locking no longer crash with a primary key constraint error
when attempting to create global locks.
An RTS 114 error occurred when copying a database-hosted file to another database-hosted file if
either the source or destination file URLs specified a datastore for which there was not an MFDBFH
configuration file entry.
"dbfhadmin -openfiles -recover" was incorrectly reporting that no files had been closed when the open
files were in the root folder.
Deleting a large number of files in a single operation sometimes failed due to the database's transaction
log becoming full when using a DB2 MFDBFH datastore.
An error message RTS 114 could occur during CASCD termination when the ES_DB_SERVER
environment variable had been set, but no associated region database was configured.
The "dbfhdeploy delete" command has been enhanced to allow the deletion of a folder (and all of its
sub-folders and files), and to allow the deletion of multiple files in a folder using a filename filter (such as
replacing characters in a file name using a wildcard, '*', and/or a question mark, '?').
Reading a record from a transactional file hosted in a PostgreSQL would hang if that record had
previously been written within the same CICS transaction.
The dbfhadmin command line utility now allows you to list/free region resources that are still locked after
a system failure. Use dbfhadmin -region -list|-recover
Active TDQs hosted in MFDBFH datastores were not displayed by ESMAC if they had records locked by
a concurrently running transaction.
CASSI processes would sometimes hang on termination, following a previous soft kill of a job, when
Db2 datastores were being used.
A new command line utility - dbfhconfig - enables you to build and maintain a database configuration
file, meaning that you are no longer required to hand-craft the file. You can also use a secrets vault to
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•

•
•
•
•

•
•
•

store sensitive logon credentials , instead of these being on view in a configuration file. Finally, a CTF
trace can be configured to trace ODBC and vault-related operations.
This product now includes the dbfhconfig utility. It enables you to create and maintain an MFDBFH
configuration file eliminating the need to manually edit the XML file. Optionally, you can use dbfhconfig
to add any passwords and connection strings associated with DSN entries to the product's secrets
vault.
Cancelling a job which was waiting for an ENQ did not always remove the ENQ request from the
(cross-)region database.
MFDBFH no longer fails if the MFDBFH_SCRIPT_DIR and/or MFDBFH_CONFIG environment
variables specify a quoted path name.
Unpredictable results could occur for applications with files open in two or more datastores due to a
clash of file handles.
It is now possible to switch on/off I/O file optimization when deploying files via the dbfhdeploy command.
Also, file optimization is now available for ESDS, KSDS, and RRDS files hosted in a database, that are
opened for input - add optio="+oi" to mfdbfh.cfg to enable.
MFDBFH now automatically reconnects the Db2 datastore and any (cross-)region database
connections when they are lost.
Intermittent ODBC errors could occur during JES initialization after the termination of an initiator
process running a job in a previous session.
dbfhdeploy incorrectly reported that a datastore did not exist for SQL Server operations when the
"master" database had not been configured. A similar issue occurred for PostgreSQL datastores when
the "postgres" database had not been configured.

Form Designer
Back to the list
•

64-bit versions of nmcnvrti.obj and nmcnvrto.obj have been added.
3207452 (1118373)

Header-to-Copy Utility
Back to the list
•

h2cpy could produce an RTS 114 error if the number of DEFINES was greater than 167.
3220579 (1119558)

Licensing
Back to the list
•

Windows Server 2016 machines might need to be restarted regularly because of a large number of
open handles on the mfcesd (Micro Focus Compliance Enforcement daemon) process. The open
handles are now freed correctly and will no longer accumulate.

•

3213000 (1118881)
The product Help now includes instructions for how to manually enable an Automatic Restart of the
SafeNet License Daemons on Linux using SystemD.

•

3210607 (1118628)
During installation, the directory structure of /var/microfocuslicensing will now have the correct and
secure permissions set.

•

3179691 (1116046)
An application being deployed using the CESDYNAMIC option of a Runtime Launch Configuration file
now succeeds in getting a licence when executed for a second time.
3160922 (1114454)
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Micro Focus Common Client
Back to the list
•

•

Memory-access errors no longer occur in MFCC (mclient.dll/ cobmclient.so/libmclient.so) when certain
malformed messages are received from the server. MFCC now detects these conditions and logs an
error message.
3213653 (1119419)
cassub and other Enterprise Server utilities now support host names of up to 255 characters long.
3196153 (1119249)

Micro Focus Directory Server
Back to the list
•

MFDS CA server root certificate and TLS client options are now available via the ESCWA UI.

•

3218442 (1119593)
The Shared Memory Cushion entry field in the Enterprise Server Administration UI now accepts five
digits.

•

3210200 (1118594)
If external security is configured for the Micro Focus Directory Server (MFDS), then a user attempting to
import region configuration using the "mfds -g" command now requires "Add" and "Delete" permissions
for the "Repository Access" resource under the "Enterprise Server Administration" resource class.

•

3209555 (1118581)
The mfds -g command line waits to time out rather than receiving an immediate fail as a result of an
import error.

•

3209555 (1118572)
In some circumstances, the Micro Focus Directory security settings were not being saved. This has
been fixed.

•

3209389 (1118705)
If the MFDS process is not TLS-enabled, setting the MF_ROOT_CERT environment variable could
cause region startup to fail. This has now been fixed.

•

3205462 (1118274)
The Micro Focus Directory Server KEEPALIVE and some other connections to a TLS-enabled
Communications Process Control Channel listener were failing to connect. This was because they were
using the IP address rather than the hostname which the certificate requires.

•

3204824 (1118193)
If the MFDS -o option is used to override the options file location, option changes were not successfully
saved. Use the same location when saving option changes, and this problem does not occur.

•

3171825 (1115391)
ESDEMO64 is now in the standard MF Directory Server startup repository together with ESDEMO. If
the MSSIVP repository is imported it contains MSSDEM64 together with MSSDEMO.

•

3168860 (1115116)
On UNIX, if the MFDS "Default process user ID" value is set, from either the GUI or with the "mfds -f"
command line option, before the MFDS process starts, it will change its effective uid to the specified
value after it has started listening on its configured endpoint. This enables the MFDS process to run
using a non-root uid while still using the default privileged port 86. If the uid specified is invalid, the
MFDS process terminates.
3122797 (1119862)
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•
•
•
•
•
•
•
•
•
•
•

If the environment variable MFDS_DNS_RESOLVE=Y is set, then the Enterprise Server Administration
web interface's HTTP response headers will not return the MF Directory Server IP address in HTTP
cookie values.
2863212 (1104835)
Previously, changes made to the listener configuration in the Enterprise Server Administration Web UI
were not becoming active for a started region.
The MF Directory Server process could abnormally terminate if the listener description text input via the
Enterprise Server Administration Web GUI was greater than 64 characters in length.
A number of XSS vulnerabilities in the Enterprise Server Administration have been resolved.
Under some circumstances, it was possible to set MFDS restricted access with improper credentials
checks.
Any region auto-start credentials and XRM open string values are now stored in the MF secrets vault
facility if the Micro Focus Directory Server is configured to use it.
When the Micro Focus Directory Server is running in a container, the region status is set to started only
when all expected listeners are started.
The mfds -l schema export command-line option now supports the OpenLDAP OLC (on-line
processing) LDIF file format (use option 4).
When adding a listener using the Enterprise Server Administration Web UI, the initial listener state was
incorrectly set to "Invalid".
In the Enterprise Server Administration Web UI, the service namespace values of the deployed REST
services were incorrectly displayed.
MFDAS XML import can now import more than one comms process.
The ESCWA API would reject adding a listener to a region if there was already a listener with the same
requested fixed port value defined in the target MFDS.

MF Server Administrator (GUI)
Back to the list
•

There is no longer an issue with using the mfds -g option to import an XML region definition with
services that reference listeners.
3219549 (1119459)

Run-Time System
Back to the list
•

•

•

•

•

The NUMVAL intrinsic function no longer produces an error at run time when used with national data in
a program compiled with a mainframe COBOL dialect.
3191506 (1117099)
The CBL_GET_EXIT_INFO library routine has been further enhanced to detect the circumstances in
which an exit procedure has been invoked. It can now better distinguish between normal and abnormal
terminations.
In .NET and JVM COBOL code, under numproc(acos), some instances of illegal data in a USAGE
DISPLAY field did not produce an RT163 error when should have.
3215249 (1119051)
.NET and JVM COBOL only. An issue has been resolved in arithmetic statements where the target item
is a binary item 9 bytes or larger (19 decimal digits or larger) and the result has magnitude which is
greater than or equal to 2**64.
In .NET COBOL, the default printer routine now successfully searches for and selects a default printer
without causing a system exception "Argument out of range".
3224679 (1119932)
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•

A statement of the form "compute item rounded = expression" where expression includes at least 1
comp-1 or comp-2 item sometimes gave the wrong result because it did not perform the rounding. This
has been fixed.
3224247 (1119910)

Setup
Back to the list
•

When installing on UNIX, the MFDS and SSL configuration files are stored under /opt/microfocus/config
and symbolically linked back to the installation location. When Patch Updates are installed to the same
location, the configuration is now preserved.
3212913 (1118927)

SQL: COBSQL
Back to the list
•

COBSQL now supports EBCDIC conversion for FETCH statements with more than ten host variables.

•

3225338 (1120132)
Informix now handles cases in which comments were included inside EXEC SQL statements or variable
declarations were broken into two lines inside EXEC SQL statements.

•

3220792 (1119585)
OpenESQL now correctly handles calling Stored Procedures with output host variables which use the
dynamic SQL method.

•

3212664 (1118834)
A problem that prevented COBSQL from reporting errors to the checker when the precompiler file was
missing has been fixed.
2867407 (1105864)

SQL: DB2
Back to the list
•

An issue with ODBC and DB2 ECM generated code not having uniquely named sections has been
resolved.

•

3224210 (1119896)
XML data is now correctly sent to the DB2 server.

•

3220909 (1119685)
DB2 ECM now handles the CLOB value in EBCDIC correctly when DIALECT(ENTCOBOL) is specified.

•

3217813 (1119335)
There is no longer a problem compiling programs with host variable arrays if they are used with the
SELECT INTO statement. A problem with the output host variable array processing where array HVs or
a mix of array and individual HVs were being processed incorrectly has been fixed.

•

3216314 (1119188)
The MFHCO tool now takes login credentials from the command line for remote database access
without asking for user inputs through a pop-up window.

•

3212431 (1118968)
A ddl command which contains a number of characters greater than 32K could cause a hang condition
in the HCO for DB2 LUW ddl generation tooling.
3205207 (1118168)
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•

•

The DB2 ECM was incorrectly handling floating point conversion when runtime option
MAINFRAME_FLOATING_POINT was enabled. This has been fixed.
3198121 (1117644)
DB2 ECM now supports multi-row FETCH/INSERT/UPDATE, which includes but is not limited to the
usage of the FOR nn ROWS clause.
3155753 (1114251)

SQL: OpenESQL
Back to the list
•

An issue with Visual Studio 2019 caused Micro Focus SQL Tools windows to appear blank. This only
occurred in Visual Studio 2019 version 16.1 or later, with .NET Framework 4.8 installed, and with the
"Optimize rendering for screens with different pixel densities (requires restart)" option enabled.
3211113 (1118674)

•

•

•

•

•

•

•
•

3225154 (1120007)
You no longer receive an error in the OpenESQL Assistant when trying to run a query that used the
same column referenced by an alias in two or more tables.
3223933 (1119902)
The SQL Server datetime values are no longer returned with trailing zeros to a host variable of PIC
X(26). An issue with the OpenESQL processing of datetime of SQL Server where padding characters
were being processed incorrectly has been resolved.
3220692 (1119579)
When calling stored procedures with null indicator host variables, the OpenESQL Run-Time System
now executes correctly without returning an SQLCODE -10000 error.
3219732 (1119869)
When multiple dynamic XA switches that use OpenESQL technology (such as MSSQL, PostgreSQL,
and ODBC switches) are specified in an Enterprise Sever instance, they are now started without an
error in xa-prepare.
3218857 (1119445)
The sqlerrd(3) in SQLCA now returns the correct number of rows affected by command INSERT and
DELETE.
3217469 (1119456)
OpenESQL runtime now handles the @@NESTLEVEL function correctly.
3211849 (1118757)
An issue with how the SQL managed runtime handles char, varchar, nchar, and nvarchar types in SQL
Server CLR stored procedures where a host variable size is greater than 8,000 has been resolved.

•

3211090 (1118718)
The OpenESQL parser now handles SQL statements inside parenthesis correctly.

•

3210644 (1118643)
The OpenESQL run-time now handles Informix ODBC errors correctly.

•

3208869 (1118722)
The OESQL managed runtime now handles FINAL TABLE statements correctly.

•
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The OpenESQL run-time system now handles WITH-HOLD cursor correctly when using FETCH FIRST
orientation.

| Resolved Issues

3208718 (1118469)
An issue with having to perform an ALLOCATE after every OPEN CURSOR to avoid an error has been
resolved.

•

3206739 (1118395)
Nested programs with the same PROGRAM-ID now insert records correctly.

•

3204730 (1118134)
Native COBOL programs with multiple program id sections no longer failed to compile in 32-bit
compilation. Previously, this failed with redefine symbol error messages.

•

3204730 (1118842)
Closing a Windows Forms application compiled with DBMAN=ADO no longer fails with a
NullReferenceException.

•

3202426 (1117914)
An issue during COBOL compilation where incorrect error messages (such as "Access plan load error"
or "DBRM not found in plan") could appear no longer occurs. This could happen in release 4.0 or later.

•
•

3202086 (1118511)
OpenESQL now handles long column names without causing a truncated data warning.
3200934 (1117832)
There is no longer an issue with expanding host variable groups regardless if whether the GEN-HVFROM-GROUP directive is applied. An issue problem with the host variable group processing where
non-sibling host variables were being processed incorrectly has been resolved.

•

3200753 (1117808)
OpenESQL now handles and recognizes SQL Server's square brackets correctly.

•

3199039 (1117614)
The OESQL JDBC run time now retrieves data correctly via the READ ONLY cursor.

•

3193117 (1117107)
The DB2 SQL scripts for the following samples now include database creation - "OO WPF Book", "OO
WPF Book EXEC ADO", and "WPF Book". Check the samples' readmes for instructions.

SQL Option for DB2
Back to the list
•

When the XDB directive option IGNORE-NESTED is used without a parameter, XDB ECM now
generates code in the outermost program only.

•

3218881 (1119399)
XDB ECM now handles multi-level group host variables correctly.

•

3215815 (1119114)
XDB ECM now handles user-defined SQLCODE data items correctly.

•

3215357 (1119066)
XDB ECM now handles group host variables in the IN predicate correctly.

•

3213813 (1118991)
A new property has been added to the XDB JDBC driver that enables byte array data to be treated as if
it were encoded in the EBCDIC code page of the connection.
3203249 (1119097)

•

•

XDB XA Switch logic now supports z/OS DB2 thread timeouts at XA_START time and reconnects stale
connections but only at XA_START.
3221852 (1119701)
A problem with XDB XA that caused a z/OS DB2 SAVEPOINT error when a program rolled back to the
SAVEPOINT has been fixed.
3216066 (1119149)
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•

A thread abend in the XDB Link on Diagnostic Information DRDA flow has been resolved.

•

3199003 (1117688)
A problem retrieving the value of the CURRENT PACKAGESET special register from the XDB Link
DRDA/AR client to z/OS DB2 has been resolved.

•

•

3186735 (1116600)
A problem that caused z/OS DB2 to return an error when using packages bound with
DYNAMICRULES=BIND in addition to specifying COMMA as the Decimal Delimiter in the Options
dialog has been fixed.
3204116 (1118276)
The warning pop-up dialog box for an invalid connection no longer appears when connecting with the
XDB ODBC Driver.
3208889 (1118496)

•

•

A problem when using the XDB V11 emulation engine that caused the SQLWizard to improperly build
UPDATE statements that update result sets has been fixed.
3209886 (1118568)
A problem with the XDB CREATE USER SQL statement's SECONDARY ID clause has been resolved.

•

3206448 (1118263)
Previously, the V11 radio button was not visible in the About tab of the XDB Server Configuration Utility
even when the V11 engine DLL was available.

•

3198729 (1117593)
A problem with recalculating field values during the projection of the result for SUBSTR/SUBSTRING
scalars with parameters 2 and/or 3 that contained field values has been resolved.

•

3196219 (1117383)
A problem caused by a case expression built in reverse order has been resolved.

•

3195822 (1117449)
The XDB Link DRDA/AR has been enhanced to process z/OS DB2 diagnostic information in all modes.

•

3187411 (1116687)
When a location was successfully closed, a problem that prevented it from being marked as closed
caused an error to be generated when subsequently setting a location off-line. This has been fixed.

•

3184848 (1116525)
An issue with labeled duration arithmetic or row change timestamps using timestamps with precision
greater than six has been resolved.

•

3181837 (1116189)
An issue causing an empty result set where index queues used to optimize correlated subqueries were
reset when the correlated subquery contained an IN predicate with a list of values has been resolved.

•

3199958 (1117713)
The XUTLB grammar that processes LOAD statements now supports a NUMRECS clause between the
INTO TABLE clause and the column definition list.

XML Support
Back to the list
•

XML PARSE now handles ISO-8859-15 encoded strings correctly in 64-bit mode.

•

3220045 (1119568)
The XML run time now handles namespace prefixes correctly in the output XML document.
3219503 (1119447)
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•

XML PARSE now returns XML EVENT correctly without repeating the same event.

•

3219154 (1119556)
The XML run-time system now detects and outputs the special xsi namespace correctly.

•

3201811 (1117879)
The PREXML preprocessor now handles the COBOL source correctly, and prevents an unhandled
exception appearing in the IDE.
3200436 (1117735)

•

If an environment variable is used in the ASSIGN TO clause, the XML runtime now returns the end-offile status correctly.

•

3220566 (1119552)
The managed XML syntax support runtime now cleans up all the unwanted empty XML tags.

•

3209096 (1118515)
XML PARSE now parses the subsequent parts of an XML document correctly.
3201432 (1117819)
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Other Issues Resolved in This Release
The numbers listed are the Support Incident Numbers followed by the Reported Problem Incident (RPI)
number (in parentheses).
•
•
•
•
•
•
•
•
•
•
•
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3220454 (1119529)
3205144 (1118152)
3216998 (1119233)
3168018 (1115086)
2868839 (1105831)
3222038 (1119767)
3184732 (1116467)
3224515 (1119919)
3136118 (1112519)
2885283 (1108043)
3211043 (1118683)

| Other Issues Resolved in This Release

•
•
•
•
•
•
•
•
•
•
•

3119471 (1110898)
3201628 (1117842)
2820860 (1099521)
3222960 (1119817)
3220991 (1119565)
3208034 (1118409)
3221354 (1119662)
3208854 (1118475)
3224700 (1119954)
3214528 (1119048)
3165853 (1114869)

•
•
•
•
•
•
•
•
•
•

3208489 (1118495)
3196128 (1117344)
3133097 (1112263)
3167774 (1115016)
3222951 (1119971)
3221465 (1119695)
3208613 (1118449)
3208093 (1118467)
3207104 (1118323)
3204665 (1118597)

Unsupported Functionality
This section includes information about features or functionality that are no longer supported.
•

The HOSTSIGNS Compiler directive is no longer supported. Micro Focus recommends that you use the
following Compiler directives instead: SIGN-FIXUP, HOST-NUMMOVE, and HOST-NUMCOMPARE.
This is a change since version 3.0 of this product.
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Installation
Before Installing
Downloading the Product
1. Use the download links in your Electronic Product Delivery email.
For more information follow the links for the installation instructions and the End User License
Agreement.
2. Alternatively, you can download the product from the Product Updates section of the Micro Focus
SupportLine Web site.

On Windows
System Requirements
Hardware Requirements
The disk space requirements are approximately:
COBOL Server
800MB

Note: This includes the space needed to cache information locally so that you can modify the
installation without the original source media.
Operating Systems Supported
For a list of the supported operating systems, check the Product Availability section on the Micro Focus
SupportLine Web site: http://supportline.microfocus.com/prodavail.aspx.
•
•

Support for development and deployment on Windows 7 has been discontinued.
Support for development on Windows 8 and Windows Server 2012 has been discontinued. These
platforms are still supported for deployment. Windows 8.1 and Windows Server 2012 R2 are supported.

Software Requirements
Note:
•
•

The setup file will check your machine for whether the prerequisite software is installed and will
install any missing prerequisites and the product components.
This product includes OpenSSL version 1.1.1c.

Before installing this product, you must have the following software installed on your computer:
•
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The Microsoft .NET Framework - the setup file installs the .NET Framework 4.5.2 . You might need to
install the following version of the .NET framework manually, if it is targeted by your applications:

•

Microsoft .NET Framework 2 - if your applications use the ILCLR(2) Compiler Directive or if they
target the .NET Framework versions 2, 3 or 3.5. You might need to download these installers
depending on the .NET Framework you are targeting.
To download the Microsoft .NET Framework 2 click here.

•

Microsoft .NET Framework 2 or later is also required for the Micro Focus License Manager if you
install this on a separate machine as a license server.
Microsoft's Web Platform Installer 2.0 if your application targets ASP.NET 4. This installs and sets up
ASP.NET. To download the installer click here.

•

A Web browser is required for Enterprise Server Administration in COBOL Server.

•

To use your Web browser offline, you need the dial-up networking feature of Windows installed.
Otherwise you might have TCP/IP errors such as being unable find "localhost" or the numeric equivalent
(127.0.0.1).
To use Enterprise Server Administration, scripting or JavaScript support must be enabled in your
browser. This is on by default in Internet Explorer in most Windows operating systems, apart from
Windows Server 2003. Also, active content must be allowed and not blocked. To enable both these in
Internet Explorer:

•

1. Click Tools > Internet Options.
2. On the Security tab, click Custom Level. In the Scripting section, under Active Scripting, click
Enable.
3. On the Advanced tab, scroll down the list to the Security section, and ensure the item Allow active
content to run in files on My Computer is checked.
Enterprise Server Help requires the Java Runtime Environment on some Windows systems to enable
the Search facility to work.
Important: For local servers, you do not need to install the Micro Focus License Administration tool
separately, as the setup file installs a new Visual COBOL client and a new licensing server on the
same machine.
If you have a network server, you must update the license server before installing the product as the
client is not able to communicate with license servers of versions older than 10000.2.660. On
Windows, you can check the version of your license server by clicking Help > About in the Micro
Focus License Administration tool. To check the version of the license server on UNIX, run /var/
microfocuslicensing/bin/mfcesver or /var/microfocuslicensing/bin/
cesadmintool.sh.
If Micro Focus License Manager version 10000.2.02070 or older is installed, it must be uninstalled
before the product installation or upgrade can continue.
You can download the new version of the license server software from the Micro Focus SupportLine.

Additional Software Requirements
To ensure full functionality for some COBOL Server features, you might be required to obtain and install
additional third-party software in addition to the prerequisite software installed automatically by the COBOL
Server setup file.
Click here to see this information on the Product Documentation pages on Micro Focus SupportLine.

Installation Restrictions and Requirements
Before starting the installation, you should consider the following:
•

You need to be logged in with a user-ID that has write access to the registry structure under
HKEY_LOCAL_MACHINE, HKEY_CLASSES_ROOT, and HKEY_CURRENT_USER so the installation
software can set the environment appropriately. You also need to be logged on with Administrator
privileges.

Installation

| 35

•

Before installing this product, make sure that any existing Micro Focus Directory Server (MFDS) or
CCITCP2 Windows service (on Windows) or a process (on UNIX) from an existing product is stopped
and uninstalled. On Windows, do this as follows:
1. Stop the MFDS and CCITCP2, using either the Windows Service Management Console GUI
(services.msc) or from a command line prompt by typing:
net stop mf_ccitcp2
Only one instance of the MFDS or CCITCP2 service can run on a Windows machine.
2. Uninstall the MFDS or CCITCP2 service.
For MFDS, from a command line prompt enter: mfds -u
For CCITCP2: ccitcp2 -u
To run an earlier version of MFDS as a service after you have installed a later version:
1. Stop and uninstall the MFDS service, as described above.
2. Reinstall the earlier version, as follows:
a. Open a COBOL Server command prompt.
b. Install the service. Enter the following command: mfds -i
c. Start the service. Enter the following command: net start mf_ccitcp2
Note: The two versions use different paths for environment and registry values, so the list of
configured enterprise servers might be different depending on which version has been started,
since, by default, different MFDS data repositories are used.
MFDS 5.1 and later are able to import or use Enterprise Server configuration data generated by earlier
versions of MFDS, but 5.0 or earlier versions of MFDS might not be able to read data generated by later
versions.
It is possible to run MFDS from a command prompt ("mfds") rather than as a service, but by default the
"mfcobol" port is used (86) and this can only be used by one process at a time

Product Co-Existence
Note: The following applies to Windows only.
•

Visual COBOL and COBOL Server cannot coexist on the same machine.

On UNIX
System Requirements
Hardware Requirements
The disk space requirements are approximately:
Platform

Installer type

Setup

Disk space

Disk space

Sentinel RMS

file size

required for

required for

license server

the installation

running
the product
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POWER
running AIX

Micro Focus

505 MB

2.02 GB

1.01 GB

41 MB

HP IA

Micro Focus

912 MB

3.65 GB

1.83 GB

79 MB

Platform

Installer type

Setup

Disk space

Disk space

Sentinel RMS

file size

required for

required for

license server

the installation

running
the product

System Z
Micro Focus
running Red Hat
Linux

396 MB

1.59 GB

792 MB

39 MB

x86-64 running
Red Hat Linux

Micro Focus

606 MB

2.42 GB

1.22 GB

50 MB

SPARC running
Solaris

Micro Focus

409 MB

1.64 GB

818 MB

42 MB

x86-64 running
Solaris

Micro Focus

381 MB

1.53 GB

762 MB

33 MB

System Z
running SUSE
SLES

Micro Focus

244 MB

976 MB

448 MB

39 MB

x64 running
SUSE SLES

Micro Focus

357 MB

1.43 GB

714 MB

50 MB

x64 running
Ubuntu

Micro Focus

361 MB

1.45 GB

722 MB

50 MB

x86-64 running
CentOS

Micro Focus

530 MB

2.12 GB

1.06 GB

50 MB

Operating Systems Supported
For a list of the supported operating systems, check the Product Availability section on the Micro Focus
SupportLine Web site: http://supportline.microfocus.com/prodavail.aspx.
Software Requirements
Note: This product includes OpenSSL version 1.1.1c.
Before installing this product, you must have the following software installed on your computer:
•
•

•

•

The "awk", "ed", "ps", "sed", tar", "sed" and "which" "tar" utilities must be installed and added to the
PATH.
The pax archiving utility is required by the setup file. Pax is distributed with most UNIX/Linux systems
but, if it is missing, you must install it separately. To verify pax is installed, run pax --help or pax -version at the command line.
On Red Hat 8.1, pax is no longer installed by default. You must install the spax version found in the OS
ISO. Use the yum install spax command.
On Red Hat, if SELinux is installed, the "SELINUX" configuration must be disabled. To do this, set
SELINUX=disabled in /etc/selinux/config.
This enables the Micro Focus License daemons to start when the machine is booted and the Micro
Focus tools and programs to run correctly.
Required libraries for Red Hat and SUSE Linux platforms - The installer checks that both the 32-bit and
64-bit libraries listed below are installed on both 32-bit and on 64-bit Operating Systems for this product
to install and work correctly.
If installing on a 64-bit OS, the 32-bit libraries are not installed by default and must be installed before
you start the installation.
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Library

32-bit
Library
Name

64-bit
Library
Name

Platform
s390

SUSE
121

SUSE 151

Red Hat 6.x

Red Hat 7

Red Hat 8

glibc2

glibc*.i686

glibcglibc*.x86_64 *.s390

X

X

X

libgcc

libgcc*.i686

libgcclibgcc*.x86_64 *.s390

X

X

X

libstdc+ libstdc+
++-*.s390
*.x86_64

X

X

X

libstdc++ libstdc+
+-*.i686

Visit the Red Hat Web site for more information.
•
•
•

1

On SUSE 12 or 15, you can only install the 64-bit version of this product. The glibc-locale-32bit library
is still required by the SafeNet Sentinel licensed components.
2On 64-bit Red Hat 7, you only need to install glibc-2.17*.x86_64 and glibc-2.17*.i686.
Java 8 (32 or 64-bit versions), and Java 11 (64-bit version only) are supported for executing JVM
COBOL code and for native COBOL and Java interoperability. You can download AdoptOpenJDK's
OpenJDK 8 with Hotspot from AdoptOpenJDK's Web site and unpack the archive anywhere on your
machine.
Note:
•

•
•

On AIX and zLinux, you need to have IBM's JDK. The earliest supported release of IBM's JDK
is 7.0 Service Refresh 8. If you install IBM's JDK 8, on AIX you must install its latest fix - JDK 8
SR5 FP16. You can get IBM's AIX JDK from IBM's Web site.
On HP-UX, you need to have HP-UX JDK. The earliest supported release of HP-UX is JDK
7.0.11. You can get the HP-UX Java JDK from HP's Web site.
On Solaris platforms (both SPARC and Intel) only the 64-bit version of Java 8 and later is
supported.

Before you start the installation, you need to set the environment as follows:
•
•

You need to set the LANG environment variable to pick up localized messages. The LANG settings are
English and Japanese only.
JavaScript or scripting support must be enabled in your browser, so that Enterprise Server
Administration is usable. Also, active content must be allowed and not blocked.
Important: For local servers, you do not need to install the Micro Focus License Administration tool
separately, as the setup file installs a new Visual COBOL client and a new licensing server on the
same machine.
If you have a network server, you must update the license server before installing the product as the
client is not able to communicate with license servers of versions older than 10000.2.660. On
Windows, you can check the version of your license server by clicking Help > About in the Micro
Focus License Administration tool. To check the version of the license server on UNIX, run /var/
microfocuslicensing/bin/mfcesver or /var/microfocuslicensing/bin/
cesadmintool.sh.
If Micro Focus License Manager version 10000.2.02070 or older is installed, it must be uninstalled
before the product installation or upgrade can continue.
You can download the new version of the license server software from the Micro Focus SupportLine.
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Additional Software Requirements on Linux and UNIX
To ensure full functionality for some COBOL Server features, you might be required to obtain and install
additional third-party software in addition to the prerequisite software installed automatically by the COBOL
Server setup file.
Click here to see this information on the Product Documentation pages on Micro Focus SupportLine.

UNIX and Linux Installer Issues
Installing while using AFS/Kerberos authentication
If you are using AFS/Kerberos authentication to log onto your Linux system then you need to ensure you
have a local user ID which SOA and Visual COBOL components of the product can use. This user ID must
be set up prior to running the installer. When running the installer you need to specify ESadminID=[User ID] on the command line so it is used by the installer.
License Server
You need to configure the computer hostname to ensure the license server will start properly.
To avoid performance issues, "localhost" and the computer hostname must not both be mapped to IP
address 127.0.0.1. You should only map "localhost" to IP address 127.0.0.1.
The following is an example of how to specify these entries correctly in the /etc/hosts file:
127.0.0.1 localhost.localdomain localhost
IP machinelonghostname machineshorthostname
where IP is the unique IP address of the computer in xx.xx.xx.xx format.

Basic Installation
The instructions in this section apply when you are performing a basic installation of this product for the
first time. If you are an administrator, you can perform a basic installation on a local machine before
performing a more advanced installation when rolling out the product to developers within your
organization.
For considerations when installing this product as an upgrade, for additional installation options or nondefault installations, see Advanced Installation Tasks in your product Help.

Installing on Windows
Note: If there is an earlier version of COBOL Server installed on your machine, check Installing as an
Upgrade first.
These are the steps to install this product:
1. Run the cs_60.exe file and follow the wizard instructions to install the prerequisite software and the
product.
The setup file will also install any missing prerequisite software as listed in Software Requirements.
Note:
•

If you are installing onto a machine that has an existing Micro Focus product that uses an older
Sentinel RMS License Manager, you might be prompted to remove it and install the Micro Focus
License Administration. By doing this you maintain the existing Sentinel RMS license files while
adding the Micro Focus License Administration. If you are unsure about existing licenses on your
computer or removing the Sentinel RMS License Manager, consult your System Administrator. If
you want to proceed, remove Sentinel RMS License Manager by using Add or Remove
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•
•
•

Programs (Windows XP) or Program and Features (Windows Vista or later), and rerun the
installation file.
Trial licenses cannot be used with remote desktop services. If you want to use your product in this
way, please contact Micro Focus SupportLine to obtain a relevant license.
We recommend that you install any updates for the .NET Framework that are available at the
Microsoft Download site.
If you install JDK you might be prompted to install the latest update. The latest update is not
required for use with COBOL Server but you can install it if you wish.

Installing on UNIX
Note: Micro Focus offers two types of installers on UNIX and Linux - a proprietary Micro Focus
installer for installing on UNIX and Linux and a standard RPM (RPM Package Manager) installer for
installing on Linux. See your product Help for instructions on how to use the RPM installer.
These are the steps to install this product using the Micro Focus installer:
1. Give execute permissions to the setup file:
chmod +x setup_cobol_server_6.0_platform
2. Run the installer with superuser permissions:
./setup_cobol_server_6.0_platform
If you don't run this as superuser, you are prompted to enter the superuser password during the install.
Note: On Ubuntu, the prompt for superuser password is not available. On this platform you must
either log in as root or use the sudo command to get root permissions before you run the installer.
If you set COBDIR to an already installed product, the installer will back up the existing installation and
will install this release in the location COBDIR points to. If COBDIR is not set, the installer does a fresh
install.
The COBOL run-time is installed by default into /opt/microfocus/VisualCOBOL, (COBDIR).
SafeNet Sentinel considerations
•

•

The installation of this product could affect the SafeNet Sentinel licensed components running on your
machine. During installation licensing is shutdown to allow files to be updated. To ensure the processes
running on your machine are not affected, you need to use the -skipsafenet option, which skips the
installation of SafeNet:
./setup_cobol_server_6.0_platform -skipsafenet
To protect the SafeNet Sentinel installation from accidental updating you can create an empty file
named SKIP_SAFENET_INSTALL in /var/microfocuslicensing/ as follows:
touch /var/microfocuslicensing/SKIP_SAFENET_INSTALL
While the file is present, the SafeNet installer does not make changes to the installation or shutdown the
running license daemons. If licensing needs to be updated later, remove the file and install Sentinel
RMS server manually.

Advanced Installation Tasks (Windows)
This section includes instructions about how to perform a non-default installation, install this product as an
upgrade, or about how to install any additional components.
The advanced installation tasks include:
•
•
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Installing as an Upgrade
Command line installation options

Click here to see this information on the Product Documentation pages on Micro Focus SupportLine.

Installing as an Upgrade
Before installing, check Installation Restrictions and Requirements.
Installing this release as an upgrade will automatically uninstall any HotFixes of the older version of the
product you have installed on your machine.
•

Before installing this release as an upgrade, ensure you create a back-up of your Enterprise Server
configuration. To do this, on the Enterprise Server Administration home page, click Export and then
select Export Enterprise Server configuration and Security Manager definitions. This creates a
backup folder in the c:\programdata\micro focus\Enterprise Developer\MFDS. You can
restore the Enterprise Server configuration after installing this release - click Import on the Enterprise
Server Administration home page.

COBOL Server Installation Options
To install COBOL Server you run cs_60.exe which contains a number of product .msi files (Windows
Installer packages). When run, cs_60.exe performs some initial system checks then sequentially installs
the .msi files.
cs_60.exe can take a number of parameters, enabling you to specify a number of different types of
installation:
•

Standard Installation

•

Format:
cs_60.exe
Summary:
Full installation including License Manager and COBOL Server. During installation you can specify
options including the location to which the components are installed.
Non-interactive Installation

•

Format:
cs_60.exe /passive
Summary:
Full installation, but the components are installed non-interactively using default options and
directories.
Silent Installation

•

Format:
start /wait cs_60.exe /q
Summary:
Full installation, but the components are installed non-interactively with no user interface, using
default options and directories.
Modified Silent Installation
Format:
start /wait cs_60.exe /q InstallFolder=d:\cobolrts
Summary:
Full installation, but the components are installed non-interactively with no user interface, and
COBOL Server is installed to d:\cobolrts.

To see what parameters you can use, execute the following from the command line: cs_60.exe /?.

Installation

| 41

Note:
•

Log files that are created during installation are saved in the folder specified by the TEMP
environment variable. To change the location or name of the files, use the /log parameter on your
setup command line and specify the path and file name, for example: filename /log d:\temp
\log.txt. This creates a log file, named log.txt, in the d:\temp directory.

Advanced Installation Tasks (UNIX)
This section includes instructions about how to perform a non-default installation, install this product as an
upgrade, or about how to install any additional components.
The advanced installation tasks include:
•
•
•

Installing as an Upgrade - included in these Release Notes
Command line installation options - included in these Release Notes
Installing using an RPM installer on Linux - available in the product Help and in the Micro Focus
Infocenter

Click here to see this information on the Product Documentation pages on Micro Focus SupportLine.

Installing as an Upgrade
This release works concurrently with the previous version of COBOL Server, so you do not need to
uninstall it.
Install the latest version in a different location and set the environment to point to it. To do this, run the
COBOL Server installer with the –installlocation option:
1. Execute the following command:
./InstallFile -installlocation="/opt/microfocus/VisualCOBOL"
Note: You can use variables when specifying an absolute path for –installlocation. For
example, the following examples are equivalent:
-installlocation="/home/myid/installdir"
-installlocation="$HOME/installdir"
2. Execute cobsetenv to set the environment and point to the new install location:
. <product-install-dir>/bin/cobsetenv
Note: cobsetenv is only compatible with POSIX-like shells, such as bash, ksh, or XPG4 sh. It is
not compatible with C-shell or pre-XPG4 Bourne shell.

Installation Options
Installing into a different location
To install in a different location use the -installlocation="Location" parameter to specify an
alternative directory location. For example:
./ -installlocation="full path of new location"
Note: You can use variables when specifying an absolute path for –installlocation. For
example, the following examples are equivalent:
-installlocation="/home/myid/installdir"
-installlocation="$HOME/installdir"
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You can see details about which additional parameters can be passed to the install script if you enter the help option.
Configuring Enterprise Server
You can use the following options to configure the Enterprise Server installation: [ -ESsysLog="Y/N" ]
[ -ESadminID="User ID" ] [ -CASrtDir="location" ], where:
-ESsysLog

Use this to enable ("Y") or disable ("N") Enterprise Server system logging. Logging is
enabled by default. Log files are saved in /var/mfcobol/logs.

-ESadminID Sets the Enterprise Server System Administrator Process User ID from the command line for example, -ESadminID="esadm". The default user ID is the one that runs the installer.
-CASrtDir

Specifies the location were the Enterprise Server run-time system files are placed - for
example, -CASrtDir="/home/esuser/casrt/es". The default location is /var/
mfcobol/es.

Installing Silently
You can install Micro Focus products silently by using command line parameters to specify the installation
directory, user information, and which features to install. You must execute the command with superuser
permissions.
You can use the following command line arguments to install silently on UNIX/Linux. You need to execute
the commands as root:
–silent -IacceptEULA
For example, execute:
setup_filename –silent -IacceptEULA

After Installing
•
•

See Changes in Behavior or Usage in your product documentation and in the Release Notes for
important information about changes in this release that might affect existing applications.
Check the Product Documentation section of the Micro Focus SupportLine Documentation Web site for
any updates to the documentation which might have been uploaded.

On Windows
To access the COBOL Server help:
•

On versions of Windows 7 and earlier, select Start > All Programs > Micro Focus COBOL Server
2017 > Documentation from the Windows Taskbar.

•

On Windows 8, right-click at the bottom of the Start screen, and click All apps to display all available
links for this product. In the COBOL Server section, click Documentation.

This opens the online Micro Focus Infocenter in a browser. From the left-hand pane, select Micro Focus
Developer > Micro Focus COBOL Server.

Repairing
If any product files, registry settings or shortcuts are accidentally removed at any point, you can perform a
repair on the installation to replace them.
To repair your installation on versions of Windows Vista or later:
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1. From the Control Panel, click Uninstall a program under Programs.
2. Right-click your Micro Focus product and select Repair.
To repair your installation on older versions of Windows, such as Windows XP:
1.
2.
3.
4.

Click Start Menu > Control Panel > Add/Remove Programs.
Click your Micro Focus product in the list of installed programs.
Click Click here for support information.
Click Repair.

Uninstalling
To uninstall the product, you cannot simply delete its files from your hard disk. To uninstall the product:
1. Log in with the same user-ID as you used when you installed the product.
2. Click Uninstall a program under Programs (or Add/Remove Programs on older versions of
Windows) in Control Panel.
3. On older versions of Windows such as Windows XP, ensure that Show Updates (at the top of the Add
or Remove Programs dialog) is checked, so that any hot fixes or WrapPacks are listed.
4. Select the product and click Remove or Uninstall as appropriate.
During the uninstall process, only those files added during the installation (to the installation and Samples
directories) are removed.
If the product directory has not been removed, delete any unwanted files and subdirectories within it using
Windows Explorer.
Important: The installer creates separate installations for Micro Focus COBOL Server and Micro
Focus License Administration. Uninstalling only COBOL Server does not automatically uninstall the
Micro Focus License Administration or any of the prerequisite software.
To completely remove the product you must uninstall the Micro Focus License Administration as well.
You can optionally remove the prerequisite software. For instructions, check the documentation of the
respective software vendor.
To silently uninstall the product, you need the setup file and you need to execute the following at the
command line:
start /wait install-file.exe /quiet /uninstall

On UNIX
Setting the Environment
When you have installed the product, you need to set the environment as described below.
1. To set up your product, execute:
. <product-install-dir>/bin/cobsetenv
2. To verify that your product is installed, execute:
cob -V
Important: These commands set the environment only for the current shell. You need to execute
them for each new shell that you start.
To avoid having to run cobsetenv for every shell, add these commands to the shell initialization files
(such as /etc/profile, /etc/bashrc).
Note that cobsetenv is only compatible with POSIX-like shells, such as bash, ksh, or XPG4 sh. It is
not compatible with C-shell or pre-XPG4 Bourne shell.
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Repairing
If a file in the installation of the product becomes corrupt, or is missing, we recommend that you reinstall
the product.

Uninstalling
Note: Before you uninstall the product, ensure that the Enterprise Server instances and the Micro
Focus Directory Service (MFDS) are stopped.
To uninstall this product:
1. Execute as root the Uninstall_COBOLServer6.0.sh script in the $COBDIR/bin directory.
Note: The installer creates separate installations for the product and for Micro Focus License
Administration. Uninstalling the product does not automatically uninstall the Micro Focus License
Administration or the prerequisite software. To completely remove the product you must uninstall the
Micro Focus License Administration as well.
To uninstall Micro Focus License Administration:
1. Execute as root the UnInstallMFLicenseServer.sh script in the /var/
microfocuslicensing/bin directory.
The script does not remove some of the files as they contain certain system settings or licenses.
You can optionally remove the prerequisite software. For instructions, check the documentation of the
respective software vendor.
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Licensing Information
Note:
•
•
•

If you have purchased licenses for a previous release of this product, those licenses will also
enable you to use this release.
The latest version of the SafeNet licensing software is required. See the Software Requirements
section in this document for more details.
If you are unsure of what your license entitlement is or if you wish to purchase additional licenses,
contact your sales representative or Micro Focus SupportLine.

To buy and activate a full unlimited license
To buy a license for Visual COBOL, contact your sales representative or Micro Focus SupportLine.
For instructions on using the Micro Focus Licensing Administration Tool, see Licensing in the Visual
COBOL help.

To start Micro Focus License Administration
Windows 8, 8.1, and Windows
Server 2012

From the Windows Start screen, click the License Administration
tile.

Windows 10 and Later

From your Windows desktop, click Start > Micro Focus License
Manager > License Administration.

Log on as root, and from a command prompt type:
/var/microfocuslicensing/bin/cesadmintool.sh

Installing licenses
You need either a license file (with a .mflic extension) or an authorisation code which consists of a string
of 16 alphanumeric characters.

If you have a license file
1. Start Micro Focus License Administration.
2. Click the Install tab.
3. Do one of the following:
•
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Click Browse next to the License file field and select the license file (which has an extension
of .mflic).

•
•

Drag and drop the license file from Windows Explorer to the License file field.
Open the license file in a text editor, such as Notepad, then copy and paste the contents of the file
into the box below the License file field.
4. Click Install Licenses.

1. Start the Micro Focus License Administration tool and select the Manual License Installation option by
entering 4.
2. Enter the name and location of the license file.

If you have an authorization code
Authorizing your product when you have an Internet connection
Note:
•

It is not possible to install licenses remotely. You must be logged into the machine on which you
are installing the licenses.

The following procedure describes how to authorize your product using a local or network license server.
The license server is set up automatically when you first install the product.

1.
2.
3.
4.

Start Micro Focus License Administration.
Click the Install tab.
Type the authorization code in the Enter authorization code field.
Click Authorize.

If you change the name of the machine running your license server after it has granted licenses, the
licenses stop working.

1. Start Micro Focus License Administration.
2. Select the Online Authorization option by entering 1 and pressing Enter.
3. Enter your authorization code at the Authorization Code prompt and then press Enter.

Authorizing your product when you don't have an Internet connection
This method of authorization is required if the machine you want to license does not have an Internet
connection or if normal (automatic) authorization fails.

1.
2.
3.
4.

Start Micro Focus License Administration.
On the Install tab, click Manual Authorization.
Make a note of the contents of the Machine ID field. You will need this later.
Do one of the following:
•
•

If your machine has an Internet connection, click the SupportLine Web link in the Manual
Authorization Information window.
If your machine does not have an Internet connection, make a note of the Web address and type it
into a Web browser on a machine that has an Internet connection.

The Micro Focus SupportLine Manual product authorization Web page is displayed.
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5. Type the authorization code in the Authorization Code field. The authorization code is a 16-character
alphanumeric string supplied when you purchased your product.
6. Type the Machine ID in the Machine ID field.
7. Type your email address in the Email Address field.
8. Click Generate.
9. Copy the generated license string (or copy it from the email) and paste it into the box under the License
file field on the Install page.
10.Click Install Licenses.

In order to authorize your product you must have the following:
•
•
•

Access to a computer which is connected to the Internet.
Your authorization code (a 16-character alphanumeric string).
The machine ID. To get this, start the Micro Focus License Administration tool and select the Get
Machine Id option by inputting 6. Make a note of the "Old machine ID".

If you have previously received the licenses and put them in a text file, skip to step 6.
1. Open the Micro Focus license activation web page http://supportline.microfocus.com/activation in a
browser.
2. Enter your authorization code and old machine ID and, optionally, your email address in the Email
Address field.
3. Click Generate.
4. Copy the licenses strings from the web page or the email you receive into a file.
5. Put the license file onto your target machine.
6. Start the Micro Focus License Administration tool and select the Manual License Installation option by
inputting 4.
7. Enter the name and location of the license file.

To obtain more licenses
If you are unsure of what your license entitlement is or if you wish to purchase additional licenses for Visual
COBOL, contact your sales representative or Micro Focus SupportLine.
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Updates and SupportLine
Our Web site provides up-to-date information of contact numbers and addresses.

Further Information and Product Support
Additional technical information or advice is available from several sources.
The product support pages contain a considerable amount of additional information, such as:
•
•

•

The Product Updates section of the Micro Focus SupportLine Web site, where you can download fixes
and documentation updates. Go to Micro Focus Product Updates
The Examples and Utilities section of the Micro Focus SupportLine Web site, including demos and
additional product documentation. Go to https://supportline.microfocus.com/examplesandutilities/
index.aspx.
The Support Resources section of the Micro Focus SupportLine Web site, that includes troubleshooting
guides and information about how to raise an incident. Go to https://supportline.microfocus.com/
supportresources.aspx

To connect, enter https://www.microfocus.com/en-us/home/ in your browser to go to the Micro Focus home
page, then click Support & Services > Support. Type or select the product you require from the product
selection dropdown, and then click Support Login.
Note: Some information may be available only to customers who have maintenance agreements.
If you obtained this product directly from Micro Focus, contact us as described on the Micro Focus Web
site, https://www.microfocus.com/support-and-services/contact-support/. If you obtained the product from
another source, such as an authorized distributor, contact them for help first. If they are unable to help,
contact us.
Also, visit:
•

•

The Micro Focus Community Web site, where you can browse the Knowledge Base, read articles and
blogs, find demonstration programs and examples, and discuss this product with other users and Micro
Focus specialists. See https://community.microfocus.com.
The Micro Focus YouTube channel for videos related to your product. See Micro Focus Channel on
YouTube.

Information We Need
However you contact us, please try to include the information below, if you have it. The more information
you can give, the better Micro Focus SupportLine can help you. But if you don't know all the answers, or
you think some are irrelevant to your problem, please give whatever information you have.
•
•
•
•
•
•

The name and version number of all products that you think might be causing a problem.
Your computer make and model.
Your operating system version number and details of any networking software you are using.
The amount of memory in your computer.
The relevant page reference or section in the documentation.
Your serial number . To find out these numbers, look in the subject line and body of your Electronic
Product Delivery Notice email that you received from Micro Focus.

On Windows, if you are reporting a protection violation you might be asked to provide a dump ( .dmp) file.
To produce a dump file you use the Unexpected Error dialog box that is displayed when a protection

Updates and SupportLine

| 49

violation occurs. Unless requested by Micro Focus SupportLine, leave the dump setting as Normal
(recommended), click Dump, then specify a location and name for the dump file. Once the dump file has
been written you can email it to Micro Focus SupportLine.
Alternatively, you might be asked to provide a log file created by the Consolidated Tracing Facility (CTF) - a
tracing infrastructure that enables you to quickly and easily produce diagnostic information detailing the
operation of a number of Micro Focus software components.
On Windows, you can use the Micro Focus SupportLine Support Scan Utility, MFSupportInfo, to create
either:
•
•

a .log file that contains the details about your environment, Micro Focus SupportLine products, and
settings.
a .zip archive that includes the same information as the .log file plus some product configuration
files from c:\ProgramData and the product installation log files.

MFSupportInfo.exe is stored in <install-dir>\bin.
To run MFSupportInfo:
1. Start a 32-bit Enterprise Developer command prompt.
2. Enter MFSupportinfo at the command prompt to start the utility.
3. Create a .log file or a .zip archive as follows:
a. To create a .log file, click File > Save.
This prompts to save the .log file, MFSupportInfo_Log_MachineName_YYYY-MM-DD_HH-MMSS.log, in the %temp% directory.
b. To create a .zip archive, click Tools > Create Zip Package.
This creates a .zip archive, MFSupportInfo_Log_MachineName_YYYY-MM-DD_HH-MMSS.zip, in the %temp% directory.
4. Send the diagnostic information to your Micro Focus SupportLine representative:
The following requires an Internet connection and an Email client:
a. Click Tools > Email Log to SupportLine to open the Email Log dialog box.
b. Fill in the required fields and click Send.
If the machine is not connected to the Internet or if there are no Email clients installed, copy either
the .log file or the .zip archive to a machine that is connected to the Internet. Use your Email client
to email the files to Micro Focus SupportLine at supportline@microfocus.com together with the Support
Incident (SI) number, if available, and any additional details that might be useful to diagnose the issues
that you are experiencing.

Creating Debug Files
If you encounter an error when compiling a program that requires you to contact Micro Focus SupportLine,
your support representative might request that you provide additional debug files (as well as source and
data files) to help us determine the cause of the problem. If so, they will advise you how to create them.
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Copyright and Disclaimer
©

Copyright 2020 Micro Focus or one of its affiliates.

The only warranties for this product and any associated updates or services are those that may be
described in express warranty statements accompanying the product or in an applicable license agreement
you have entered into. Nothing in this document should be construed as creating any warranty for a
product, updates, or services. The information contained in this document is subject to change without
notice and is provided "AS IS" without any express or implied warranties or conditions. Micro Focus shall
not be liable for any technical or other errors or omissions in this document. Please see the product's
applicable end user license agreement for details regarding the license terms and conditions, warranties,
and limitations of liability.
Any links to third-party websites take you outside Micro Focus websites, and Micro Focus has no control
over and is not responsible for information on third party sites.
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